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1. Overview:

LCDMaster is very powerful Visual Screen Builder for color graphic displays. It allows you to easily create
high-end graphics for embedded applications, without the need for expensive operating system and/or GUI
library, no software licensing or production fees and without the processing power normally required for
embedded GUI systems.
LCDMaster is a true WYSIWYG visual GUI builder requiring absolutely no coding for the GUI design.
This allows the marketing and sales personal to involve directly in creating a unique look and feel for their
products, while the embedded engineers can focus on writing and connecting the main application code to
the created GUI.

GUI design and development made easy
 - Build a user-centric GUI instead of an engineering-centric one.
 - Avoid costly product changes late in the development cycle.
 - Use drag-and-drop simplicity.

An upfront GUI
Get input from designers, engineers, and usability experts in the earliest stages of development.

Codeless development
Build and test graphics visually in real-time, without application code, third-party libraries, or
recompilation.

Prototype to product
Quickly create a complete, working, user-centric interface without impacting the product development
schedule

2. Features:

·  No license! No production fees! No third party library! No RTOS!
·  True WYS|WYG visual GUI tool
·  Simple drag-and-drop GUI tool
·  Full support for SegeMax Support all SEG-Cx and MAX-Cx Display modules
·  Alignment Tools (Left, Right, Top, Bottom or Center)
·  Select box (move the selected objects at the same time)
·  Snap to Grid tool Move and Resize Tools
·  Copy and Paste Complete Screens from Project to another.
·  Powerful predefined set of objects
·  Real time user interface simulation
·  Real time object properties simulation
·  Bitmap editor/converter utility
·  Font converter utility
·  Full screen bitmap loader utility
·  One click compile and program
·  Generate project report
·  Copy and Paste tools
·  Zooming
·  Window's bitmap to binary converter utility
·  Export screen as a bitmap
·  Terminal commands utility TouchScreen, Backlight, Keyboard, DigitalI/O, PWM, RTC, Beep utilities
·  PC Playback allows the user to view and interact with the production-ready GUI in the native

resolution on the PC before programming the LCD. Easy compile feature allows the embedded
designer to view the GUI design, at any stage of development,�on the LCD module in minutes. This
process virtually eliminates the simulation phase that is standard in other products.
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3. System requirements:

·  Intel Pentium 4, Intel Centrino or Intel Core Duo (or compatible) processor
·  High resolution 17” LCD monitor or higher
·  Windows XP, Windows Vista or Windows 7
·  CD-ROM drive
·  512 MB RAM or higher
·  USB or RS232 Port

4. Installation:

·  Insert the CD into your CD-ROM drive
·  Copy the folder “LCDMasterProVxxxx” and paste it to your hard drive C
·  From your hard drive C, open “LCDMasterProVxxxx” and double click on “Setup.exe”
·  Follow the instructions on screen to complete the installation
·  To run the software, click on “Start” and navigate to “LCDMasterPro Vxxxx” and then click on

“LCDMasterProVxxxx”

5. Interface:

RS232 serial bus is used to communicate with the serial controller or the panel. You can use a USB to
serial converter if your PC have not a serial port. Not all USB to serial converters in the market today have
the same performance, some of them may be not suitable for high speed interface. From our experience, we
recommend to use Prolific USB to Serial converter.

6. Starting a new project:

We highly recommend keeping all project files which includes Window’s bitmap (.bmp), Binray bitmap
(.bin), Fonts (.bin), Project (.pjt) and Report (.txt) on one location.
To start a new project (for example Demo1), please follow the steps:
1. From your hard drive C, create a new folder and name it “Demo1”
2. Open “Demo1” and create the following new folders: Fonts, ImageList0, ImageList1, ImageList2,

ImageList3, ImageList4 and ImageList5.
3. From the main menu, select “New Project”, select your target hardware and then click on “Apply”
4. From the main menu, select “Save As”, browse to “C:/Demo1/”, enter the project name (e.g.

Demo1.pjt) and then click on “Save”
From now, save all the project fonts and bitmaps to their corresponding sub folders, For example, save all
fonts to “Fonts”, save all ImageList0 bitmaps (.bmp and .bin) to “ImgeList0” folder and so on.

7. Product Select Utility:

The Product Select Utility provides fast and easy way to configure the software for specific product.
All supported products are listed on the “ProductList.txt” text file, which is saved in the application path.
The user must select the appropriate product before starting a new project. This will automatically
configure the software to the product specific settings. To select a product:
·  Select the appropriate product form the product list
·  Click on “Apply” to save and configure the software
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8. Comm port, Baud Rate and Device ID Settings:

The Communication window is used to set the communication Com. port number, baud rate and device ID.
The selected baud rate and Device ID (communication address) must match the selected product baud rate
and device ID.  Also, the selected com port must exist in your PC and not be in use by another application.
The default values for the baud rate and device ID for all modules are:
Baud Rate = 115.2Kb/sec, Device ID = 0x10 = 16
If you use a USB to serial converter, the installed com port can be from 1 to 255. In this case select
“Other” and enter the com port number. To test the communication between the software and the selected
product:
·  Make sure that the product under control is powered on and connected to your PC serial port using

Standard RS232 Cable
·  Click on “TEST”
·  If the test is successful, the TEST LED will turn into Green, the product number and firmware will be

displayed.
Note: USB communication is not supported by the current version.

9. LCD Controller Configuration Utility:
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This utility is used to configure the target hardware or panel for particular display and set the
communication baud rate, device ID and, select the power up options.
See SegeMax Software reference manual for more information about configuration bytes.
Note: Dip-Switch 3 must be ON “User Configuration” for the new configuration to take place.

Power Up Options:
·  BackLight ON/OFF: This will configure the LCD controller to turn the LCD backlight ON or OFF at

power up or after a reset.
·  Load Screen: This will configure the LCD controller to load and show a screen (ID). The screen (ID)

must be existed in the flash memory in order for this option to work.
·  Enable TouchScreen: This will configure the LCD controller to enable or disable the touch screen

controller
·  Default Backcolor: This will set the default back color.
·  GP Output states: This will set or clear the corresponding general purpose digital output if they are

available.
·  System Colors: This will set the system colors as been defined in “Edit Display Window” utility.
Communication:
·  Device ID: This will set the communication address ID
·  Baud Rate: This will set the communication baud rate
LCD
This tab will be only enabled if the target product or hardware is “SegeMax-LCD”.  This will configure the
graphic controller timing registers to the target display. From the target LCD data sheet, select the LCD
resolution and enter the timing parameters and then click on “Apply And Calculate” button. The calculated
parameters table will be updated with a new values. If all the calculated parameters are within the specified
range, then the “Program” button will be enabled and you can now program the controller EEPROM with
the new values. If any of the calculated parameters is out or range, then it will be displayed in Red and you
need to readjust one or more of the LCD timing entries.

To program the configuration bytes, click on “Apply” and then click on “Send”.  If the operation is
successful, you will receive an ACK and you need to power the target hardware OFF and then power it ON
for the new configuration to take place.
In case the baud rate and/or the device ID locations are corrupted or you are not able to communicate with
your target hardware. Set Dip-Switch 3 to “Default Settings or OFF” and then sequence the power (power
off then on). This will set target hardware baud rate to 115200 bit/sec and the device ID to 16.
From the communication utility, set the device ID to 16 and select 115200 baud rate and then click on
“TEST”. If the test was successful then, from the “LCD Controller”, set the device ID and the baud rate to
your desired settings and then click on “Apply” and then “Send”. Power the target hardware OFF and set
Dip-Switch 3 to ON again. Power the target hardware ON and the new configuration should be in place.
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10. Touch Screen Utility:

This utility is used to test and calibrate the touch screen.

11. Terminal Utility:

This utility is used to test the Terminal commands. See “SegeMax Software Reference Manual” for more
information about the terminal commands.

Touch Status

Touch
calibration
coefficients

Scan Touch
screen

Calibrate
Touch
Screen

                                      

Touch
coordinate

Touch
Pressure

Virtual
Touch
Screen

                                  



10

12. Bitmap Editor:

This utility is used to edit bitmaps or convert bitmaps to binary format.

To save a window’s bitmap (.bmp) to the target hardware flash memory:
1. Select ImageList. The bitmap will be saved in this image list.
2. Click on “Open” and select the bitmap (.bmp) file. An error message will be displayed if the bitmap

width or height is higher than 255 or if the bitmap size is larger than the ImageList Max. bitmap size.
3. Set the bitmap back style. If you select “Transparent”, click on “Pick Transparent color”, move the

mouse cursor to the bitmap transparent color and then left click. The value of the selected transparent
color will be displayed on the text box. Make sure that, the transparent color is only existed in the area
that you like to be transparent (not drawn).

4. Click on “Send To LCD” icon. The bitmap will be displayed on the upper left corner of the target
display.

5. Select “Save Mode”. “Get Free ID” mode will automatically find a free ID location for the selected
image list. “OverWrite” mode will over write the bitmap ID entered in “Bitmap ID” box. If you select
“OverWrite” then, set the bitmap ID before saving. To check how many IDs are still available for the
selected imagelsit, click on “Check Flash” icon, the free and used bitmaps will be displayed.

6. Click on “Save to Flash” icon.
7. To display the bitmap, click on “Show From Flash”.
8. To save the bitmap in binary format to your PC, click on “Save”, the name of the bitmap will be

automatically generated as “IDx-ILx-bitmap name” then click on “save”. In binary format, the bitmap
ID and ImageList code will be saved in the bitmap header.
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13. Font Editor

This utility is used to convert a system font to binary format and to save it to the target hardware flash
memory.

Eight fonts are provided for proportional writing. In proportional writing, the characters are written
according to their width with one blank pixel between them. All characters are written with proportional
spacing. The character width and height are automatically calculated for the selected character.
The imported font size should not exceed the maximum character cell size, which is 24X40.

TTF Import:  A Windows TTF font is vector based, and will be drawn using the full color depth of the
Windows system. This results in many shades of gray being used to represent the individual character. As
fonts in LCDMaster are purely monochromatic (only two colors, or pixel states, on and off) there must be
made some sort of conversion, reducing the gray-scale Windows characters to black-and-white LCDMaster
font characters. The black/white ratio slider determines how dark a pixel must be, in order for LCDMaster
to perceive it as black, and not white. Some fonts are best imported with the slider near the middle position,
while others will be better represented if the slider is pushed more toward the right. It is easy to experiment,
because the import can be repeated again and again, using slightly different slider settings. If the import
covers a very large range of characters a smaller sub-range can be used when adjusting the slider, in order
to speed up the response.

To convert a system font to binary format and save it to the target hardware flash memory:
1. Click on “Import System Font” button, select font name, size and style then, click on “OK”.
2. Adjust the TTF slider if it is necessary.
3. Click on “Convert” button to convert the font to binary format.
4. Select “Save Mode”. If you select “OverWrite”, then enter Font ID number. If you select “Get Free

ID”, and then the font ID number will be automatically determined by the target hardware firmware. In
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case you have selected “Get Free ID” and all available font IDs are already used, then you need to
select “OverWrite” mode and to enter an ID number.

5. Click on “Save To Flash” to save the font to the target hardware flash memory.
6. To display a character on the target hardware display, click on a character (will turn into red) and then

click on “Show Font” icon.
7. To save the converted font to your PC, click on “Save” , enter font name and click on “Save”
8. To open a binary font file (.bin), click on “Open”, highlight the font and then click on “Open”

14. Image Loader:

This utility is used to save a full screen bitmap (Image) to the target hardware flash memory

To save an image to the display flash memory:
1. Click on “Load Image” to load an image (Full screen bitmap)
2. Click on “Convert”
3. Click on “Send To LCD” button to send the image to the display
4. After the whole image is already shown on the target display, select “Save Mode” and ID and then

click on “Save to Flash” button.
5. To display an image from flash, select image id number and then click on “Show From Flash” button.

15. Bitmap to binary converter:

This utility is used to convert a list of window’s bitmaps (.bmp) to binary (.bin) with a single click!  Each
bitmap in the list will be converted to binary and saved at the same location as the window’s bitmaps. The
Bitmap ImageList, Backstyle and Transparent color will be set for all bitmaps according to your settings.
Bitmap ID will be automatically set for each bitmap starting form “ID Start”. All converted bitmap will the
saved with the following name format:
IDn_ILm_BitmapName
Where:
N is the bitmap ID
M is the bitmap ImageList
BitmapName: is the name of the window’s bitmap

Always check the “ID Start” before converting so you do not over write already converted or saved
bitmaps. Also, be sure that all bitmaps in the list has a size equal or less than the maximum size for the
selected ImageList and the number of bitmaps in the list is equal or less than ID End – ID Start.
If you are going to convert a list of bitmaps that are a part of Animation or Image Sequence then be sure
that they are loaded in the proper sequence.
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To convert a list of window’s bitmaps (.bmp) to binary:
1. Be sure that the list is empty. If it is not, click on “Remove All”
2. Click on “Add Bitmaps” button, the Open dialog will be displayed. Browse to the location of the

bitmaps and then hold “Ctrl” down and select multiple bitmaps at the same time. If you are going to
convert an array of bitmaps, then start from the bottom of the array list. For example, if you are going
to convert Battery1.bmp to Battery8.bmp, then select Battery8.bmp first, then Battery7.bmp and so on.

3. Select the ImageList
4. Select the BackStyle. If the backstyle is “Transparent”, then click on the color picker button and from

the bitmap preview window, move the mouse cursor to the bitmap transparent area and then right click
to capture the Transparent color. The backstyle and transparent color will be set for all bitmaps in the
list.

5. Enter the “ID Start”. Be sure this ID is available for the selected image list. For example, if you already
convert 10 bitmaps starting for ID Start = 0 and save them in ImageList0 and you want to convert
another 15 bitmaps, then you need to set ID Start to 10.

6. Click on “Convert”. Each bitmap in the list will be converted to binary and saved to the same location
as the window’s bitmaps starting form the first one in the list. The ID of each bitmap will be
automatically set as an increment of the previous one and starting from “ID Start”.
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16. Main Window:

                                                                                                                                                                   
The main window has four panels:
16.1. Virtual Display:
The Virtual Display is basically a picture box where you will be able to graphically layout your application
screens. It has the same resolution as the target display with zoom in and zoom out capability.
16.2. Project Manger:
The Project Manger displays a hierarchical list of the project screens and all the objects contained by each
one. Clicking on a screen node in the list will automatically show the screen on the virtual display and, if
“Show the screen on the target display” is checked then, the screen will also be shown on the target display.
Clicking on an object in the selected screen list will highlight the object (the color of the object turns into
Yellow) which will allow you to use the layout tools to edit, move or delete the highlighted object.
16.3. Object Menu:
The Object Menu shows all LCDMaster predefined objects. Clicking on any of the object buttons will open
the “Object Property” window. Edit the object properties and then click on “Add” to place the object on the
virtual display.
16.4. Main menu:
The Main Menu all the software current functions.
·  File Functions:

New Project: Starts a new project.
Open Project: Opens a project.
Save Project: Saves a project under the current name.
Save Project As: Saves the project under another name
Copy Screen: This will copy the selected screen to the internal buffer. This is can be used to copy a
screen from one project and paste it to another project.
Paste Screen: This will paste the copied screen to the project
Export Screen As Bitmap: Exports the current screen as window’s bitmap (.bmp). This allows you to
open the exported screen using any Graphics design software and uses its tools to print or edit the
screen picture.
Exit : Exits the software.
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·  Edit Functions:
       Display: Edits the virtual display colors and other settings
       Palette: Edits the palette colors for 8-bit systems.
       Highlight All:  Highlight all objects.
       Unhighlight All:  Unhighlight all objects.
       Delete: deletes all highlighted objects.
·  Project Functions:
       Select Product: Selects a product form the product list.
       Load Font: Loads a new font (.bin) to the software font list. This will not affect the target hardware
       fonts. For example, use the font editor to create a new font, save it to your PC and then use this
       Utility to save it to the application font memory.
       Add Floating Bitmap: This utility will add a floating bitmap
       Compile And Program Screen: Compile and program the current screen only.
       Compile And Program All:  Compile and program all the project screen.
       Generate Header File: Generates a C compatible project header file (.txt). This file contains all
       commands, codes, object property codes and all the project screens and objects names and IDs.

·  SetUp Functions:
       Communications: Edits the communication settings.
       LCD Controller:  Edits and program the target hardware configurations.
       Options: Edits the software starting up options.

·  Utilities Functions:
       Font Editor:  Displays the font editor utility.
       Bitmap Editor:  Displays the bitmap editor utility.
       Image Loader: Displays the image loader utility.
       Bitmap To Binary Converter:  Displays the bitmap to binary converter utility.
       Terminal:  Displays the Terminal utility.
       Touch Screen: Displays the touch screen utility.
       Keypad: Displays the keypad utility.
       Digital I/O:  Displays the Digital Input/Output utility.
       Analog In: Displays the Analog input utility.
       PWM:  Displays the PWM (Pulse Width Modulation) utility.
       Backlight:  Displays the back light utility.
       Beep: Displays the beep (buzzer) utility.

·  Help Functions:
      About: Displays the About screen.
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16.5. Layout and Programming tools:

16.5.1. User interface Simulation:
This utility allows you to test and manually simulate the objects touch zones. The object command
“Screen_GetUiMsg” is sent periodically every ~250msec, the received user interface message is decoded
and displayed. The host controller will use the same command to capture the user interface message.
Please, check SegeMax Software Reference manual for more information.

Selected Screen/Window
Highlighted Object
Highlighted Object ID and Code

Object Usage Gauge
Screen/Window Usage
Gauge

Grid Step Size
Run and Stop Buttons

Move Highlighted
Object Right, Left,
Up and Down

Current
mouse X,Y

Highlighted
Object X,Y

UI (Touch
Screen)
Simulation

Object Simulation

Compile & Program
All Screens

Compile & Program
Selected Screen Only

Program a List of Fonts

Program a List of Bitmaps

Program a List of Images (Full Screen Bitmaps)

Align Left
Align Right
Align Up
Align Down
Align Center
Snap To Grid
Deselect All
Select
Move
Adjust Width
Adjust Height
Adjust Both
Not Used
Pointer

Paste Object

Copy Object

Delete Object

UnHighLight All

Edit Object Properties

View/Hide Grid

Zoom Out

Zoom In
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To start the user interface simulation:
1. Select the screen that you want to perform this simulation on and be sure that is already displayed on

the target hardware display too.
2. Click on “User Interface Simulation” button
3. The user interface simulation window will be displayed. The touch zones for the screen objects will be

drawn in red.
4. Click on “Scan”
5. From the target hardware display, touch an object and at same time observe the response on your PC

monitor.

16.5.2. Object Commands Simulation:

This utility allows you to test the object commands and manually simulate your GUI even before your
hardware and code to be ready. Also, it is a great tool to debug your code during the design process. All
object commands, object properties and methods are supported.
For example, you can play an animation, write a text to textbox or button label, move a radial gauge needle,
fill a chart with array of numbers and so on. The data sent and received are also displayed for debugging
and testing purposes.
Please, check SEGE Software Reference manual for more information about the object commands,
properties and methods.

To test an object command or method:
1. Select the screen that contains the target object and be sure that is already displayed on the target

hardware display.
2. Click on “Object Simulation” button.
3. The “Object Simulation” window will appear.
4. From the “Screen Object List”, select the object.
5. From the “Object Properties List”, select the property that you need to set or to get
6. From the “Object Command List”, select the object command or method and enter the command data

(string, byte, word or dword) if Object_SetProperty is selected.
7. Click on “Send” and observe the change on the target display.



18

16.5.3. Compile And Program:
This utility is used to compile a single screen (selected screen) or all the project screens into a binary file
(Hex file) and send it to the target hardware to be saved in the flash memory. Every time you create a
screen or edit an object, then you need to compile and program. After you compile and program a screen,
click on the screen in the project manger (make sure that “Show screen on target display” is checked) to see
the new one or changes on the target hardware.

16.5.4. Program a List of Fonts:
This utility allows you to program a list of fonts with one click!

To program a list of fonts:
1. Click on “Add” and browse to the fonts location. Hold “Ctrl” down and select one or more font file

(.bin). The number of fonts in the list should not exceed the maximum allowable number of fonts
which is 8. The order of the fonts in the list is not important as each font has its ID and ImageList Code
already saved in the file header.

2. Click on “Program”. Each font in the list will be saved (Over Write) into the target hardware flash
memory starting from the first one in the list.

3. Wait until all fonts are programmed and then click on “Close”.
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16.5.5. Program a List of Bitmaps:
This utility allows you to program a list of bitmaps (.bin) with one click!

To program a list of bitmaps in binary format:
1. Click on “Add” and browse to the bitmaps location. Hold “Ctrl” down and select one or more bitmap

files (.bin). The order of the bitmaps in the list is not important as each bitmap has its ID and ImageList
Code already saved in the file header.

2. Click on “Program”. Each bitmap in the list will be saved (Over Write) into the target hardware flash
memory according to its ID and ImageList Code and starting from the first one in the list.

3. Wait until all bitmaps are programmed and then click on “Close”.

16.5.6. Program a List of Images (full screen bitmaps):
This utility will program a list of images (.bmp) with one click!

To program a list of bitmaps in binary format:
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1. Click on “Add” and browse to the images (.bmp) location. Hold “Ctrl” down and select one or more
image files. The order of the images in the list is very important as the ID for each image in the list will
be an auto increment (+1) of the previous ID starting from the first one in the list (ID = 0).

2. Click on “Program”. Each image in the list will be saved (Over Write) into the target hardware flash
memory according to its ID and ImageList Code and starting from the first one in the list.

3. Wait until all images are programmed and then click on “Close”.

16.5.7. Copy/Paste Object/Screen:
To copy and past an object:
1. Highlight the object you need to copy.
2. Click on “Copy Object” button. The “Paste Object” will be enabled.
3. Click on “Paste Object”. The object will be pasted at the upper left corner of the virtual display. The

software will generate a unique name for the new object and add it to the project manger.

16.5.8. Delete an Object:
To delete an object:
1. Highlight the object you need to delete
2. Click on “Delete Object” button. A message box will be displayed to confirm the action. Click on

“Yes” and the object will be deleted. This action is undoable.

16.5.9. Edit Object Properties:
To edit an object properties:
1. Highlight the object you need to edit its properties.
2. Click on “Edit Object Properties” button. The object properties window will be displayed. Edit the

properties and then click on “Edit”. You must Compile and Program the screen to save the changes to
the target hardware flash memory.

16.5.10. Zoom In and Zoom Out:
The zooming feature is only available if the target display resolution is QVGA (320X240) or less. For
higher resolution, only the actual size of the target display resolution will be displayed.
For QVGA resolution or less and if the screen back style is background image, then you need to save the
background image with actual size (e.g. 320X240) and with double the size (e.g. 640X480). Only the actual
image size will be saved into the target hardware flash memory, the second one is only for the software
zooming function. Both images must be saved at the same path as the project.
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17. Starting Up Options:
At starting up, LCDMaster can be configured to load fonts and object bitmaps and to set the
communication port number, baud rate and Device ID. Those configuration or options will be saved as text
file “Config.ini” to the application path “C:\Program Files\LCDMasterV2.00”.
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To configure the starting up options:
1. From the main menus, select “SetUp” and then select “Options”
2. The “Options” window will be displayed with the current options.
3. Select “Communication” and enter your new settings.
4. Select “Bitmaps”, uncheck ImgeList2 to clear the list and then check it again. Click on “Browse” and

navigate to the new bitmaps location, select the bitmaps and then click on “Open”. The list will be
populated with new bitmaps files. Do the same for ImageList3 and 4 if required.

5. Select “Fonts”, uncheck Font0 to Font7 to clear their paths and then check Font0. Click on “Browse”
for Font0 and navigate to the new Font0 location, select font0 file and then click on “Open”. Font0
path will be displayed. Do the same for Font1 to 7.

6. Click on “Apply” and then click on “Close’
7. Exit the application.
8. Start the application again for the new options to take place.

18. Load Font:
This utility is used to load a font file (.bin) to the application font memory. It is very useful to test new
fonts created by using the font editor.

19. Generate Header File:
This utility is used to generate a C compatible header file for the project. This text file contains all
commands, properties and object ID.
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20. Objects:
Please, see SegeMax Software Reference manual for more information about each object properties.

20.1. Screen/Window Object:

To add a screen to an project:
1. From the object menu, click on the “Screen” button.
2. Screen object properties window will appear. Set the screen properties and then click on “Add”
3. The screen will be added to the project and to the project manger list.
4. To edit the screen properties, click on the screen name in the project manger list, the screen will be

shown on the virtual display.
5. Click on “Edit” button and the screen object properties window will appear. Edit the screen properties

and then click on “Edit”
Note1: Every project must have at least one screen. When you start the application, Screen_0 will be added
automatically and can not be deleted.
Note2: If you set the backstyle to Image, then you need to load both images if the target display resolution
is 320X240 or less. You also need to enter the Image ID (the image must be saved into the target hardware
flash memory at that ID). Both images must be windows bitmaps (.bmp) and must be saved at the same
path as the project.

20.2. BarGraph Object:

                                                

Bargraph Name

Bargraph Bitmaps.
Only if style is bitmap.
One bitmap for OFF or
Cold segment.
One bitmap for ON1 or
Hot1 segment.
One bitmap for ON2 or
Hot2 segment.

Bargraph bitmaps
preview

Bargraph value
For simulation only

Bargraph colors. Only
if style is line

                                                         

Screen/Window
Name

Screen ID. The Screen ID is
automatically generated by
the application

Image (Full screen bitmap) ID
You must enter valid Image ID
if you set the backstyle to
Image.

Actual Screen size
background Image
For example: 320X240

X2 image is double the size
of the actual image. For
example: 640X480
Only used for the zooming
feature.

Object Type Screen
Or Window

Only for Window
Width and Height

Only for Window
Start Up Position (X,Y)

Only for Window
View or Hide

User Interface (Touch) mode.

User Interface (Touch) Update
Rate. For example, every 100msec
the controller will read the touch
(X,Y) and scan the objects
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To add a Bargraph to a screen:
1. From the object menu, click on the “Bargraph” button.
2. Bargraph object properties window will appear. Set the Bargraph properties and then click on “Add”
3. The Bragraph will be added to the project manger list under the selected screen node.
4. Move the mouse cursor to inside the virtual display and left click to place the object.
5. To edit the Bargraph properties, click on the screen name in the project manger list, the screen will be

shown on the virtual display and then click on the bargraph name to highlight it (Yellow frame will be
drawn around the object). Click on “Edit” button and the Bragraph object properties window will
appear. Edit the Bragraph properties and then click on “Edit”. You can also move it by clicking on the
moving buttons.

20.3. Button Object:

                                              

                                              

Button bitmaps.
One for Not Pressed.
One for Pressed.
One for Disable
(optional)

Font, Label Color and
Label. Only if style is
Bitmap&Label.

Add any character from
32 to 255 to the button
label

Label width, height, #
of characters and # of
lines

Button bitmaps preview

Enable the button
Touch Zone

Touch Zone Offset
If the button is touched,
beep for 250msec

If the button is touched,
enable NotifyHost pin.

If the button is touched,
automatically toggle its
state.
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To add a Button to a screen:
1. From the object menu, click on the “Button” button.
2. Button object properties window will appear. Set the Button properties and then click on “Add”
3. The Button will be added to the project manger list under the selected screen node.
4. Move the mouse cursor to inside the virtual display and left click to place the object.
5. To edit the Button properties, click on the screen name in the project manger list, the screen will be

shown on the virtual display and then click on the Button name to highlight it (Yellow frame will be
drawn around the object). Click on “Edit” button and the Button object properties window will appear.
Edit the Button properties and then click on “Edit”. You can also move it by clicking on the moving
buttons.

20.4. TextBox Object:

To add a TextBox to a screen:
1. From the object menu, click on the “TextBox” button.
2. TextBox object properties window will appear. Set the TextBox properties and then click on “Add”
3. The TextBox will be added to the project manger list under the selected screen node.
4. Move the mouse cursor to inside the virtual display and left click to place the object.
5. To edit the TextBox properties, click on the screen name in the project manger list, the screen will be

shown on the virtual display and then click on the TextBox name to highlight it (Yellow frame will be
drawn around the object). Click on “Edit” button and the TextBox object properties window will
appear. Edit the TextBox properties and then click on “Edit”. You can also move it by clicking on the
moving buttons.

                                             

TextBox text. Multi line is
supported. Max 64
characters

Text #of lines, #of
characters, width and height

TextBox back color and
fore color. Back color is
only valid for standard
style

TextBox width and height.
For Standard style, adjust
the width and height
according to the selected
font, text alignment and text
width and height. Text will
be clipped if it is wider or
higher than the textbox.
For Static style, the textbox
width is the text width and
its height is the text height.



26

20.5. NumberBox:

To add a NumberBox to a screen:
1. From the object menu, click on the “NumberBox” button.
2. NumberBox object properties window will appear. Set the NumberBox properties and then click on

“Add”
3. The NumberBox will be added to the project manger list under the selected screen node.
4. Move the mouse cursor to inside the virtual display and left click to place the object.
5. To edit the NumberBox properties, click on the screen name in the project manger list, the screen will

be shown on the virtual display and then click on the NumberBox name to highlight it (Yellow frame
will be drawn around the object). Click on “Edit” button and the NumberBox object properties window
will appear. Edit the NumberBox properties and then click on “Edit”. You can also move it by clicking
on the moving buttons.

20.6. Slider Object:

                                               

NumberBox Digit Bitmaps.
The digit bitmaps (24
bitmaps) must be saved into
ImageList2, ImageList3
or/and ImageList4. At starting
up, the application will load
them automatically from the
path you have entered on the
“Starting Up Options”
window.

Scroll up/down to see all
the 24 digit bitmaps

NumberBox simulated
value. You can test the
function of the
NumberBox by entering
different numbers and
see the effect on the
virtual display

                                                 

Slider background and
control bitmaps.

Slider Range

Control bitmap Offsetx and
Offsety relative to the body
bitmap. You adjust the offset
by editing the slider and
observe the effect on the
virtual display

Slider bitmaps preview

Slider simulated value.
Adjust the slider value
and observe the effect on
the virtual display
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To add a Slider to a screen:
1. From the object menu, click on the “Slider” button.
2. Slider object properties window will appear. Set the Slider properties and then click on “Add”
3. The Slider will be added to the project manger list under the selected screen node.
4. Move the mouse cursor to inside the virtual display and left click to place the object.
5.    To edit the Slider properties, click on the screen name in the project manger list, the screen will be
shown on the virtual display and then click on the Slider name to highlight it (Yellow frame will be drawn
around the object). Click on “Edit” button and the Slider object properties window will appear. Edit the
Slider properties and then click on “Edit”. You can also move it by clicking on the moving buttons.

20.7. PictureBox Object:

                                              

Enable the Slider Touch
Zone

Touch Zone Offset

Beep when the slider is
touched

Notify host when the
slider is touched

Automatically move the
slider control or handle
when is touched and
dragged

                                                 

PictureBox background
bitmap. If the picture box
has no background bitmap
then it will be filled with
the back color.

Enable free hand drawing.
PictureBox Touch Zone must be
enabled.

PictureBox background bitmap
preview

PictureBox width and
height.
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To add a PictureBox to a screen:
1. From the object menu, click on the “PictureBox” button.
2. PictureBox object properties window will appear. Set the PictureBox properties and then click on

“Add”
3. The PictureBox will be added to the project manger list under the selected screen node.
4. Move the mouse cursor to inside the virtual display and left click to place the object.
5. To edit the PictureBox properties, click on the screen name in the project manger list, the screen will

be shown on the virtual display and then click on the PictureBox name to highlight it (Yellow frame
will be drawn around the object). Click on “Edit” button and the PictureBox object properties window
will appear. Edit the PictureBox properties and then click on “Edit”. You can also move it by clicking
on the moving buttons.

20.8. Image Object:

To add a Image to a screen:
1. From the object menu, click on the “Image” button.
2. Image object properties window will appear. Set the Image properties and then click on “Add”
3. The Image will be added to the project manger list under the selected screen node.
4. Move the mouse cursor to inside the virtual display and left click to place the object.
5. To edit the Image properties, click on the screen name in the project manger list, the screen will be

shown on the virtual display and then click on the Image name to highlight it (Yellow frame will be
drawn around the object). Click on “Edit” button and the Image object properties window will appear.
Edit the Image properties and then click on “Edit”. You can also move it by clicking on the moving
buttons.

                                            

Load the Image object
bitmap array. For both styles
Animation or
ImageSequence, the bitmaps
in the array must be saved
into the flash memory in
sequence. ImageCount
determines the number of
bitmaps in the array.
All bitmaps must be saved to
the same ImageList.

First bitmap in array
preview

ImageCount = Number
of bitmaps in the array.
Array StartIndex = First
bitmap ID in the array
Array EndIndex = Last
bitmap ID in the array.
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20.9. Shape Object:

To add a Shape to a screen:
1. From the object menu, click on the “Shape” button.
2. Shape object properties window will appear. Set the Shape properties and then click on “Add”
3. The Shape name will be added to the project manger list under the selected screen node.
4. Move the mouse cursor to inside the virtual display and left click and hold the left button, move the

mouse to draw the shape then release the left button to place the shape.
5. To edit the Shape properties, click on the screen name in the project manger list, the screen will be

shown on the virtual display and then click on the Shape name to highlight it (Yellow frame will be
drawn around the object). Click on “Edit” button and the Shape object properties window will appear.
Edit the Shape properties and then click on “Edit”. You can also move it by clicking on the moving
buttons.

20.10. Chart Object:

                                            

                                                

Series colors

Chart Back Color

Chart area width and height
will be calculated based on
Xmax, Ymax and Xspace.

Width = Xmax * Xspace  + 4
Height = Ymax + 4
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To add a Chart to a screen:
1. From the object menu, click on the “Chart” button.
2. Chart object properties window will appear. Set the Chart properties and then click on “Add”
3. The Chart will be added to the project manger list under the selected screen node.
4. Move the mouse cursor to inside the virtual display and left click to place the object.
5. To edit the Chart properties, click on the screen name in the project manger list, the screen will be

shown on the virtual display and then click on the Chart name to highlight it (Yellow frame will be
drawn around the object). Click on “Edit” button and the Chart object properties window will appear.
Edit the Chart properties and then click on “Edit”. You can also move it by clicking on the moving
buttons.

20.11. Needle Object:

To add a Needle to a screen:
1. From the object menu, click on the “Needle” button.
2. Needle object properties window will appear. Set the Needle properties and then click on “Add”
3. The Needle will be added to the project manger list under the selected screen node.
4. Move the mouse cursor to inside the virtual display and left click to place the object.
5. To edit the Needle properties, click on the screen name in the project manger list, the screen will be

shown on the virtual display and then click on the Needle name to highlight it (Yellow frame will be
drawn around the object). Click on “Edit” button and the Needle object properties window will appear.
Edit the Needle properties and then click on “Edit”. You can also move it by clicking on the moving
buttons.

                                                

Needle background bitmap.
Only if the style is
AnalogMeter.

Needle preview. Move the
value slider to move the
needle.

Needle OffsetX and
OffsetY. Only if the style is
Analog Meter.

Needle Range = from 0
 to 360

– (Amin
 + Amax
)
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21. Getting Started with LCDMasterProV2.00:
The installation CD includes a sample projects “VGADemo”, “QVGADemo” and WVGADemo”. This
Demo project has 8 screens and 4 windows. It shows the many powerful features of the GUI objects and
how to interact with them in real time. Also, our evaluation board EVL-CA32 has a sample code written in
C for PIC32 for this Demo project.

22.  Manual Change History:

Date Revision Change
7/23/2010 REV 1.00 Initial Version of the LCDMaster

Reference manual
12/16/2011 REV 2.00 Updates for the new version
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Tutorials
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Frequently asked questions:

1. How to change the Baud Rate?
·  Set the Dip-Switch # 3 to OFF position (Default settings). This will set the baud rate to

115.2Kb/sec and DeviceID to 16. Powered the Display module OFF then ON.  Ignore this step if
Dip-Switch # 3 is already on OFF position.

·  From the main menu, select “SetUp” >> “LCD Controller” >> “Communication”. Set the baud
rate to your desired value and then click on “Apply”. Click on “Send” to program the EEPROM
with the new settings.

·  Power the display module OFF. Set Dip-Switch # 3 to ON (User Defined Settings) and then power
it ON again.

·  From the main menu, select “Communication”, be sure that the baud rate and device ID are the
same as the display module and then click on “Test”. You should receive an ACK.

2. Can I copy and paste Screen/Window from one project to another?
Yes you can!
·  Open the project that you need to copy the screen/window from and select the screen/window
·  From the main menu, select “File” >> “Copy Screen”. Now, the selected screen is copied to the

internal buffer.
·  Open the project that you need to paste the screen to.
·  From the main menu, select “File” >> “Paste Screen”. The copied screen will be added to the

project with a name “Screen/Window_ID”.

3. Can I add a grid to a chart object?
You can add a grid to chart by placing a window over the chart.  This will allow you to view/hide the
grid, change the grid color and style and even change the grid vertical or horizontal spacing without
effecting the chart. The Oscilloscope screen (Demo Project) uses the same method to add a grid to the
oscilloscope chart.
·  Add a window to your project and call it “Chart_Grid” for example.
·  Set the window width and height to be as close as the chart width and height.
·  Set the window background color to the same color as the chart background color.
·  Set the Chart Screen “UI Mode” to ScreenOnly. This will disable the window from receiving any

touch events.
·  Enable the window Transparency and set the Transparent color to the background color
·  Add vertical and horizontal lines to the window using the Shape Object.

4. How to change the window background to an image?
Window by default only has a solid color background. However, you can add an image to a window by
inserting a bitmap (Image Object) with the same size or smaller to the window. The only disadvantage
is the size of the window is limited to the size of the background bitmap. For example, ImageList7 can
hold a 254X254 bitmap, which will set the window size to 254X254.

5. Can I make a round corner window?
Yes you can. Just enable the window Transparency and set the Transparent Color to the color of the
window corners. When the window is displayed, this color will not be drawn and the window will
appear as round. This also allows you to make circular or elliptical windows. Just be sure that the
transparent color is unique for the whole window.

6. Can I add a text cursor to a text box or picture box?
The easiest way to do that is to use a floating bitmap. Assign your cursor bitmap to the floating bitmap
and use the floating bitmap methods (commands) to move it according to the entered text width and
height. You can also flash it by view and then hide it at constant rate. The Text Screen (Demo Project)
uses the same method to add a cursor to the text box (Picture Box).
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7. How can I generate a text file with the object names, IDs and codes?
From the main menu, click on “Project” >> “Generate Header File”, click on “File Name” and select
the file name. Click on “Generate”. This will generate a text file similar to C header file with the entire
project names and IDs for each screen or window. Also, command codes, object codes, object property
codes are included. You just need to copy and paste to your code or simply add this file as a header file
to your C code.

8. Can I display an animated processing icon to a screen?
You can use the floating bitmap to do that. Save the icon bitmaps as an array in one of the image lists.
Your micro will send FB_Bitmap command to change the floating bitmap to the next one at a rate
depends on the process. One the process is done, your micro will send to hide the floating bitmap.
Also, you can disable the UI during this time by using UI_Enable command.

9. Can I move a group of objects at the same time?
Yes. Click on “Select” icon and select the objects, use the move buttons to move them to anywhere
inside the view area and then click on “Deselect” icon.

10. What is “Time Out Error”?
This error means that the time for receiving a command response took longer than the specified time
(~5sec). Please, check the RS232 cable and be sure that both the LCDMaster and the target hardware
have the same the baud rate and Device ID.

11. What is “Communication Error 8005”?
This error is mostly caused by the USB to RS232 driver and the operating system. Some USB to
RS232 converters cause this error to appear more than the other. For best results, use a PC with actual
RS232 port.
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Creating a New Project (Demo):
1. From you hard drive C, create a new folder and name it “Demo”
2. Open “Demo” folder, create 7 folders and name them as following: Fonts, ImageList0, ImageList1,

ImageList2, ImageList3, ImageList4 and ImageList5.
3. Start LCDMaster, select File > New Project and select your target hardware product (SEG-CQ57-LOT

or SEG-CQ57-LHT) and then click on “Apply”. The LCD resolution is QVGA (320X24).
4. Select SetUp > Communication, select a valid com port number and click on “Apply”. Leave the baud

rate at 115.2kb/sec and Device ID at 16. Click on “Test” to check the communication between the PC
and the target hardware. Make sure that the target display is already powered on and the connected to
the PC serial port through a standard RS232 cable.

5. Select File > Save As, standard window save dialog will appear, browse to “Demo” , name the project
“Demo.pjt” and then click on “Save”

Creating a New Font:
1. Select Utilities > Font Editor, click on “Import System Font” and windows standard “Font” dialog will

appear. Scroll down and Select “Arial”, set the font style to “Regular” and size to “8” and then click on
“OK”.

2. The font characters will be displayed on the font table. Click on a character (turn into red) to see it on
the character matrix.

3. Click on “Convert” to convert the font into binary format.
4. Select “OverWrite” for Save Mode and enter 0 for the Font ID. The font will be saved as “Font0”.
5. Click on “Save To Flash” and wait until the font file is completely sent and saved into the flash

memory.
6. To check if the font is converted and save correctly, click on a character (e.g. “A”) and then click on

“Show Font”. Character “A” will appear at upper left corner of the target display. You can also use the
terminal utility to write lines of text on the target display and see how this font looks like on the
display.

7. If you are happy with font, click on “Save” and browse to “C:\Demo\Fonts”, name the font as
“Font0_Arial_8_R” and then click on “Save”.

8. To load this font to the LCDMaster font memory, select Project > Load Font, click on “Browse” and
navigate to C:\Demo\Fonts\Font0_Arial_8_R and click on “Open”. Select “Font0” for the target font
and then click on “Load”.

9. To load this font at every time you start LCDMaster, select SetUp > Options, click on Font tab, click
on Font0 Browse button and navigate to C:\Demo\Fonts\Font0_Arial_8_R , click on “Open” and the
font path will appear on Font0 path label. Click on “Apply” to the save the changes to “Config.ini”
file.

Demo Project first screen (Screen_Demo):
1. Copy “WindowForm.bmp” and “WindowFormX2.bmp” form

“C:\LCDMasterProV1.00\Projects\Demo1\ImageList5” and paste them into
“C:\Demo\Fonts\ImageList5”. We will use “WindowForm.bmp” as a background image for
Screen_Demo.

2. From the project manger, click on “Screen_0” and then click on “Edit object Properties”. The “Screen
       Object properties” will appear, name the screen as “Screen_Demo”, select “Image” for the back style
       and enter 0 for the image ID.
3. Click on “Load” for X1 Image and browse to “C:\Demo\Fonts\ImageList5\WindowForm.bmp” and
        then click on “Open”. Do the same for X2 Image and select “WindowFormX2.bmp”.
4. Click on “Edit”. The new screen name “Screen_Demo” will appear in the project manger list and the
        screen back ground image will appear on the virtual display.
5. Now we need to save the background image to the flash memory at ID = 0. Click on “Program Image
       List”, add “WindowForm.bmp” and then click on “Program”.
6. Now we need to save the screen to the flash memory. Click on “Compile And Program Current
       Screen” and then click on “Start”.
7. Make sure that “Show Screen on the target display” is checked and then click on “Screen_Demo”. The

Screen should appear on the target display.
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Add a Button to Screen_Demo:
1. Copy “StartGDown.bmp” and “StartGUp.bmp” from C:\LCDMasterProV1.00\Bitmaps and paste them

into “C:\Demo\ImageList0”. StartGUp.bmp is for the button Not Pressed or Up state while
StartGDown.bmp is for the button Pressed or Down state.

2. Now we need to convert the two bitmaps from windows bitmap format (.bmp) to binary format (.bin).
Select Utilities > Bitmap To Binary Converter, click on “Add Bitmaps”, browse to
C:\Demo\ImageList0 and select both bitmaps. Select “ImageList0”, Opaque, and set the ID Start to 0.

3. Click on “Convert”. The two bitmaps are converted to binary and saved to ImageList0 as
ID0_IL0_StartGUp.bin and ID1_IL0_StartGDown.bin.

4. Now we need to save the converted bitmaps to the flash memory. Click on “Program Bitmap List”, add
ID0_IL0_StartGUp.bin and ID1_IL0_StartGDown and then click on “Program”.

5. Now we need to add the button to Screen_Dem0. From the Object Menu, click on “Button” , Button
Object Properties will appear. Name the button as “Button_Start”, set the Style to “Bitmap” and set the
type to “Momentary”. Select “Not Pressed” and click on “Load”, navigate to “ID0_IL0_StartGUp.bin”
and click on “Open”. Select “Pressed” and click on “Load” again, navigate to
“ID1_IL0_StartGDown.bin” and click on “Open”. Click on “Input/Events” tab, check “TouchScreen”
for the Input Type, and check also Beep, NotifyHost and Toggle.

6. Click on “Add” and then on “Close”.
7. Move the mouse cursor to inside the virtual display, a rectangle with the button dimensions will appear

at the tip of the cursor. Click on “Left” to place the button.
8. Now we need to save the changes to Screen_Demo. Click on “Compile And Program Current Screen”

and then click on “Start”.
9. Click on “Screen_Demo” and the new screen should appear on the target display.
10. Touch the button using your finger or a stylus and the button should change its state from Not Pressed

to Pressed and beep for 250msec.
11. You can also check the screen user interface using the “User Interface Simulation” utility.
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12. Also, you can examine and test the screen run time properties and methods using the “Object Run
Time Simulation” utility.

Converting the button bitmaps to binary
format

Button_Start Properties
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Add a bitmap style BarGraph to Screen_Demo:
1. Copy SegH_Off_8X24.bmp, SegH_On_8X24.bmp and SegH_OnR_8X24.bmp from

C:\LCDMasterProV1.00\Bitmaps and paste them into C:\Demo\ImageList0. The first bitmaps is for
the cold or off segment, the second for the Hot1 segment and the third is for the Hot2 segment.

2. From “Bitmap To Binary Converter” utility, add those three bitmaps, select ImageList0, set the back
style to Transparent, click on “Color Picker” button and move the mouse cursor to the bitmap corner
(transparent color is white) and “Left” click. The white transparent color value will appear on the
transparent color label.

3. The Start ID should be “2” as we already use ID 0 and 1 for the button bitmaps.
4. Click on “Convert”. The bitmaps are converted to binary and saved in ImgeList0 as

ID2_IL0_SegH_OFF_8X24.bin, ID3_IL0_SegH_On_8X24.bin and ID4_IL0_SegH_OnR_8X24.bin
with back style set to Transparent and the transparent color is white.

5. Click on “Program Bitmap List” and add the converted three bitmaps. Click on “Program” to save
them to the flash memory.

6. Click on “BarGraph” button. Name it as “Bargraph_Bitmap”, set the style to “Bitmap”, set the type to
“Bar” and orientation to “Horizontal”. Select “Cold” and click on “Load”, navigate to
ID2_IL2_SegH_Off_8X24.bin and then click on “Open”. Do the same for “Hot1” and “Hot2”.
Set SegmentCount and SegmentSpace to 8.

7. Click on “Add” and then on “Close”
8. Place the bargraph on the virtual display.
9. Click on “Compile And Program” to save the new changes to the flash memory.
10. Click on Screen_Demo and the new screen should appear on the target display.
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To change the bargraph value on the target display:
1. Click On “Object Command Simulation”, select Bargraph_Bitmap, select “Value” property and then

select “Opject_SetProperty”.
2. Enter 0,3,1 and then click on “Send”. (0,3) is the word value of the bargraph (0x0003) and 1 is the

bargraph segment index. 0 > Off, 1 > Hot1, 2 > Hot2.
3. On the target display, the first 3 segments will turn into “Hot1” bitmaps (Green).
4. Enter 0,3,2 and then click on “Send”, the first 3 segments will turn into “Hot2” bitmaps (Red).


